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Introduction 

AppleTalk Remote Access is software that lets your Macintosh computer communicate 

with another Macintosh or an AppleTalk network over standard telephone lines, giving 

you convenient and direct access to information and resources at a remote location. For 

example, if you're away from your office but need to get a file from your Macintosh 

there, Remote Access can make the connection between your home and office 

computers. When you use Remote Access to call your office computer from your 

Macintosh at home (or wherever you're using a Macintosh with a modem), you can use 

Macintosh file sharing to access the files you need. 

AppleTalk Remote Access lets you go beyond using just the resources of one 

computer-if the Macintosh you call is connected to an AppleTalk network, you can 

take advantage of all the se1vices available on the remote network. For example, you can 

check your electronic mail, access files on AppleShare file servers, or print to a 

LaserWriter printer on the network. You can also access host services from your 

Macintosh, using gateways on the network. 



Sen•ices such as mail. file sharing 
jlle se1vice. and printing can be 
accessed remote~) '. 

About this guide 

2 Introduction 

This guide explains how to install and use the AppleTalk Remore Access software. This 
introductory chapter tells you \\·hat you need to get started and provides you with 
instructions on how to install the software. Chapters 1 and 2 detail how to ser up and use 
Remote Access. Chapter 3 tells you how to keep information on your network secure 
and ho\\" to monitor Remote Access activities. Appendix A provides information on using 
modems with Remote Access. Appendix B contains troubleshooting suggestions. 

This guide assumes you are already familiar with the Macintosh desktop as well as 
wirh basic Macintosh skills, such as using the mouse and using the Chooser. If you're 
unfamiliar with these skills, refer ro the manuals that came with your computer. 



You should also understand basic networking concepts and have experience using 

nenYork services like electronic mail , file setvcrs, and printers. For more information on 

rhe networking features or your Macintosh. sec the networking chapter in the Macintosh 
User's Guide or in your System 7 documentation. 

On-screen help 

AppleTalk Remote Access includes on-screen information that you can consult when 

you need help. Balloon Help is a feature of System 7 that explains the function or 

significance of items you see on the Macinrosh screen. To turn on Balloon I Ielp, pull 

clown the l lelp menu from the Help icon (the question mark) ncar the right end of the 

menu bar. and choose Show Balloons. When you point to an item on your screen, a 

balloon with explanatory text appears next to the item. To turn off Balloon Help, choose 

Hide Balloons from the Help menu. You can also choose Remote Access Information 

from the Help menu. Remote Access Information provides you wirh a series of on-screen 

cards that explain how to use Remote Access. 

For n1ore inforn1ation 
If you want more information about networks and networking, see the following books 

from Apple Computer (published by Addison-Wesley Publishing Company and available 

at your local bookstore): 

• Understanding Computer Network.s describes networking basics, including types of 
networks, nel\,·ork components, net\\·ork media. and telecommunications. 

• me Apple Talk Netu•ork ~)'Stelll Oueruieu• provides a technical introduction to the 
structure and implementation of the AppleTalk ne[\\-ork system protOcols. 

• Planning and .Hanaging AppleTa/1(. t\'ettwrk.scxplains in dera il how ro administer a 

small- ro medium-sized AppleTalk net\York. 

For more infotmation 3 



What you need to get started 

To use AppleTalk Remote Access, your Macintosh computer must be running system 
sofrware version 7.0 or later with at least rwo megabytes of memory, although four 

megabytes are recommended. You also need an appropriate Hayes-compatible modem 
with a data rate of at least 2400 hits per second (bps). See Appendix A for more 
information on which modems you can use with AppleTalk Remote Access. The 
Macintosh computer you call must also have AppleTalk Remote Access software installed 
and a modem attached. 

If you received AppleTalk Hemote Access in the box with your computer, your 

package includes: 

• one 1.4 MB (high-density) disk, titled IJ7sta!ler 

• this manual. the AppleTalk Re111ote Access User's Guide 

If you purchased AppleTalk Remote Access from an authorized Apple reseller, your 
package includes: 

• t\\'O 8001\ disks. titled Installer Disk I and Installer Disk 2 

• this manual, the AppleTa/k Re111ote Access User's Guide 

The Installer disk (or disks) include the sofro·are and the Installer program that you'll 
use to install AppleTalk Remote Access soft,\'are on your ~ lacintosh. 

Installing AppleTalk Remote Access 
on your computer 

4 Introduction 

Folio" · the steps in this section to install the Remote Access software on your computer. 

• Note The follo'i\·ing instructions assume your computer has a noppy disk drive. If 
you don·r ha,·e a floppy disk dri\·e. you can install over a net\\·ork or directly from a 
desktop .\lacintosh. , ee your .llacintosh l 'ser's Guide for more information. • 



1 Insert the disk Installer (or 11lstaller Disk 1) into your floppy disk drive and 
double-click the Installer icon to open the program. 

IMMifitt 

The Installer prompts you to iclenrify the software you \\·ant to install and the disk where 

you wamto install it. 

2 Select the disk where you want to install Remote Access, t11en click Install. 

The installation process begins. If you ·re installing from two 800K disks, the Installer will 

prompt you to insert fllStaller Disk 2 before conrinuing. 

The Installer cannot install Remote Access software on your Macintosh if any application 

programs are open. Ymt"l l receive a prompt if you have any programs open, and you can 

choose to quit the open programs and continue the installation process or to cancel the 

installation process. 

When the Installer has fi nished, a dialog box appears to let you know that the installation 

\ras successful. 

3 Click Restart to restart your computer. 

In~ra llation is no\\· complete. The Remote Access icon appears on the disk directory, 
while other components of AppleTalk Remote Access reside in your System Folder. 

Later, ymt"lluse these other components to set up connection information. 

Install ing Apple Talk Remote Access on your computer 5 



1 Answering Calls 
With Ren1ote Access 

Once you've installed AppleTalk Remow Access software on your Macinrosh, you can 

allo,,· other users to call your computer and. through 1\ lacimosh file sharing. you can 

share and exchange files. If your computer is connected to an AppleTalk network, other 

users can also access all of the sen·ices your network provides. such as file sen·ices and 

electronic mail. Remote users can e,·en use the Laser\Vriter printers connected to your 

ner,,·ork. You still have full use of your computer ,,·hilc it answers a call from another 

user and doesn·t need the Remote Access program robe open in order to ans,,·er calls

Remote Access will ans,ver automatically in the background. This chapter describes how 

to ser up Remote Access for your tvlacintosh to anS\\"Cr ca lls. 



Indicating your tnodem setup 
Before your ~ lacinrosh can answer calls, you need to connect your computer to an 
appropriate modem. ·ee Appendix A for a list of modems that you can use with 
AppleTalk Remote Access, as well as what to do if your modem isn't among those listed. 

Though you can use a modem capable of transmining ar least 2400 bps. Apple 
recommends that you use a 9600-bps modem. 

The documentation that came ,,·ith your modem " ·ill explain ho\Y to set up the 

modem for use \\'ith your computer. Once you·ve properly connected the modem. you 
need to register modem information \\'ith Remote Access. Follow the steps in this section 
to indicate your modem setup to the AppleTalk Remote Access software. ~lake sure 
you've already installed the Remote Access software according to the instructions in the 
Introduction. 

1 Double-click the Remote Access icon to open the program . 

.....!... 

~t 

An untitled connect ion dowlllelll appears. Ignore this for now, because it 's used to call 
another ~ l acinrosh ; you'll work with connection documents in Chapter 2. 

2 From the Setup menu, choose Remote Access Setup. 

The Remote Access Setup control panel opens. The top portion of the control panel is 
where you indicate your modem setu p. 

8 Clwpler I Answering Calls With Remote Access 



• Note Another way to open the Remote Access Setup comrol panel is to choose 
Control Panels from the Apple Ctl) menu. then clouble-dick the Remore Access Setup 

control panel. • 

Remote Access Set up 

~ Modem Setup 

Modem I Appl• Mod•m 2400 • I Port : 

Mod•m Sp•aker : @ On 0 Off 

~ Remote Access Answering Setup 

0 Answ~r calls 

0 Mix tmum conntctlon tlmt · ~.~ i mmutts 

~ · 
Mod•m Port 

A How ~cctss to : @ tntirP network 0 this Macmtosh only 

3 Choose your modem type from the Modem pop-up menu. 

Press the ~lodem pop-up menu. Drag through the list and choose the name of your 
modem. If your modem doesn't appear, refer to Appendix A for further information. 

;;;o Remote Access Setup 

~ 
0 

Modem Setup 

~ Mod•m : ... Por· t : 
. . ,, . .. . 

DSI 9624 LEILE Plus Mod•m Port 

Mod•m Sp Ha<J•s Ultra 
Microcom MacModtm 
T•l•bit T1 600 

~ Remote Access Answ ering Se tup 
. 

0 Answer calls 

D Maximum connection time : r·a·""'''''''l minutes 
\, . ....... : 

Allow access to : @entire- network 0 this Macintosh on I~ 
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4 Choose the port to which your modem is connected from the Port pop-up 
menu. 

If you don't kno,,· which pon your modem is connected to, look at the back of your 
\ lacinrosh. The port where the modem is connected has an icon abo,·e it. \Yhich looks 
like the ~ lodem or Printer po11 shm\'11 in the follo\\'ing figure. 

Rem ot e Recess Setup 

0 
0 ~ Mod em Setup 

Mod•rn I Appl• Mod•m 2400 • l Port : 

Mod•m Sp•ak•r : @ On 0 Off 

~ Remote Access Answ ering Se tup 

0 Answtl'r calls 

0 Ma>dmum eonnechon hme : r~: .. · ... ~.] minutes 

Printer Port 

Allow acc•ss to · @ •ntir• n•tvork 0 this Macintosh only 

Setting up Ren1ote Access to answer calls 

The Remote Access Setup control panel is where you set up Remote Access so your 
Macintosh can answer calls. Using the lower half of the control panel, you answer calls 
from users, limit access. and set connection time limits. f-ollow these steps to set up 
Remote Access so that other users can call your Macintosh. 

1 If the Remote Access Setup control panel isn't open, choose Remote Access 
Setup from the Sentp menu. 

2 Click the "Answer calls" checkbox. 

[8] Answl't" calls 
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An X should appear in the checkbox to indicate you've selected this option. This lets 

your J'vlacintosh answer calls from registered users. (Registering individual users is 

CO\-erecllater in this chapter.) When this option is selected and your phone rings, your 

Macintosh answers the call, even if the Remote Access program is not open. 

• Note If you have a service on your phone such as call " ·airing, then a second 

incoming call will disconnect you. Contact your local phone company to find our how to 

turn off call waiting " ·bile you use Remote Access. • 

3 Click the "Maximum connection time" checkbox, then set the maximum 
connection time in minutes. 

[8] Max imum connection t ime : ~ minutes 

To ensure that remote connections arcn't lcft idle for a long period of time, you can set 

your ,\ lacintosh to disconnect calls after a certain amount of time. The amount of time 

depends upon \\·hat you expect people to do. ~lake sure to account for slo\\'er 

transmission rates and to allm\' user · enough time to complete procedures. 

When this feature is selected. a user who has called your :VIacintosh can remain 

connected for the time specified. The user recei\·es a warning ten minutes before being 

disconnected. another warning five minutes before. and another \\'arning two minutes 

before being disconnected. Your Macintosh disconnects the call when the maximum 

time period. as specified in the box, has passed. 

• Note If you do not select this option. the user can remain connected for an 
unlimited period of time. Howe\·er, you can disconnect a user directly (rather than by 

speci~·ing a time limit). as discu ·sed in the section -~ Ion itoring and Disconnecting a 

Cser" later in this chapter • 

Sening up Remote Access to answer calls 11 



4 Make sure you allow access to the entire network. 

-

Allow access to : @entire network 

Do you want callers to han~ access 10 all the services on the network to \\'hich your 

computer is connected? If so, the "entire m:twotk' button should be highlighted. 

Otherwise. callers have access only 10 your Macintosh and the services available on ir. 

such as folders you \ ·e shared through file sharing. 

) Close the Remote Access Sernp control panel. 

Preventing users fro111 calling 
your Nlacintosh 

Follow these steps to prevent all users from calling your Macintosh: 

1 Double-click the Remote Access icon to open the program, if necessary. 

2 From the Sernp menu, choose Remote Access Setup. 

3 Click the "Answer calls" checkbox. 

0 Ans\•/o?r calls 

NO\\'. no one will be able to call your Macintosh. If you \\·ant to prevent access by 

specific users, you need only re\'Oke their access privileges. This procedure is covered 
later in this chapter, in the section "Naming a Registered User.., 
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Registering users 

By registering users. you let specific users call your Macintosh. You identify each user 

and gi,·e each a password; if you choose, you Gill also allmv guests to call. as explained 

later in th is chapter. Before any user or guest can call, a corresponding user or guest icon 
must exist in the Users&. Groups control panel on your Macintosh. 

Important Remote Acce:-,s uses the same User &. Groups control panel as that used for 

Macintosh file sharing and program linking. If you're already set up a user for file 

sharing, use the same user icon to set up the user's remote access to your computer. 

laming a registered user 

The Remote Access soft\\·are automatically sets up a user file for you. the ~'lacintosh 

mmer. using the 0\\'!1Cr name specified in the Sharing Setup control panel for Macintosh 

111e sharing. If you aren't using file sharing, you'll need to set up a user file for yourself 

according to the instructions in this section. You can register as many as 100 users. 

Follow these steps to register a user: 

1 Open the Remote Access program, if necessary. 

2 Choose Users & Groups from the Setup menu. 

• Fi le Edit 

You can also choose Control Panels from the Apple menu, as you normally would to 

access any control panel, then double-click the Users & Groups icon. 

Registering users 13 



3 Choose New User from the File menu. 

An icon ti tled New User appears. 

0 User s & Groups e::J= 
4 items 7.4 118 in d1sk I I .2MB availabl• 

0 0 [] & 
Q 

<Gu•st> Ronald Patrick 

-o 
¢1 1¢ 121 

4 Type the name of the person you want to register. 

This name must match the spelling the user enters to call this Macinrosh, but 

capital ization doesn·t matter. Make sure you notify the user of the exact name you type. 

Setting a registered user"s password 
and allowing a user to call 

Assigning passwords to registered users is one way of making sure that only authorized 

caller· can gain access to your computer. 

1 Open a user icon in the Users & Groups control panel. 

Double-cl ick the user icon you just created. That user's Remorc Access options are 

displayed at the bottom of the winclo,,·_ under the options for file sharing and program 

linking. For information on file sharing and program linking, refer to the .llacintosh 
Cser s Guide or rour S\·stem - documentation. 
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--~"~D~~~i1M~a~r~y~A~d~a~m~s~~~~~~~-~-~ Type :1 p:tss11·ord = 
for this user here. User Password : f 

LJ File Sharing 
,~. 18] Allow user lo connec l 

[g) Allow user to change password 

~ Program linking 
~ 0 Allow user to Hnk to proqrams 

on this Macintosh 

~ Remote Access 

Click this box to /D Allow user 
10 

dr
101
-'"-------, 

---T~-----" 0
1 

Callbockat• -
1 

:tllow this u~cr to L __ _:t====~====~:!__ call your Clir" th i~ box :tnd tl·p.: in the number rour 
~ lacimosh . romputt•r will c:tll. 

2 Type a password in the User Password text box. 

This pass~·orcl is ~vhat the user must enter to call your Ivlacintosh. The password can be 
up to eight characters long. \lake sure to inform the user of the exact pass\-vord. 
including capitalization. 

3 Click the "Allow user to dial in" checkbox. 

18] A llo\1' user to dia 1 in 

This lets the user call your Macintosh. Later, if you want to revoke this user's access, you 
can cl ick the checkbox again to deselect rhis option. 

Registering users 15 



4 Click the "Call back at #" checkbox and type in the user's telephone number. 

[S] Ca 11 back at # : 19 ,555-1 234 

Selecting this option means that when the user calls your Macintosh, your Macintosh will 
temporarily disconnect the user, then immediately call the user back at the number 
you've entered. The callback feature is optional; it provides an extra level of security, 
because the user must call from a predetermined phone number. 

The callback number is the telephone number from which the user is calling. You enter 
the phone number as ir you were dialing directly. If your Macintosh needs to dial an 
outside line (as in many business phone systems), type the outside line number follmved 
by a comma. For example, type 9 , 55 512 3 4 . Type in the area code, if necessary, and 
enter international phone numbers in the same way. You can type hyphens in the 
number to make it easier to read, but it is not necessary. Also. if you turn off the callback 
option, the phone number remains but is unused. 

+ Note Remote Access uses touch-tone dialing. For information on pulse dialing and 
other characters interpreted by the modem, refer to Appendix A. + 

5 Close the user window. 

You'll be asked whether to save the information. After you've saved the information, 
your Macintosh can answer calls from that user. 
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Allowing guests to call your Nlacintosh 

AppleTalk Remote Access enables you to a limY nonregistered user ·. called guests. to call 

your t\ lacintosh. Unlike registered users. guests do not enter a user name or pass\Yorcl 

\Yhen calling your ~ lacintosh. 

Important \X'hen you allow guests to call your Macintosh. you dramatically reduce its 

security fearures. You cannot specify a pass\\'ord or turn on the callback option for guest 
users. It is strongly recommenclccl that you do not allow guests if your network contains 

sensitive information. For more information on security, refer to Chapter 3. 

Folio~· these steps to set up a guest user: 

1 Open the Remote Access program, if necessary. 

2 Choose Users & Groups from the Setup menu. 

3 Double-click the <Guest> icon. 

The <Guest> user \rindo\\· opens, \\·hich contains information similar to other user 

windows. The Remote Access options are displayed at the bottom of the ~·indow. under 

the oplions for file sharing and program linking. 

<Guest> 

Q Fi le Sharing 
'~' 

0 Allow guests to conneoct 

~ Program linking 

0 Allow guests to link to programs 
on this Macintosh 

~ Remote Recess 

Click 1h1' box 10 --+--0 Allow gu•sls to d•al m 

allow gul''l accl'''· 

Allowing guesrs ro call your Macintosh 17 



4 Click the "Allow guests to dial in" checkbox. 

-

Selecting this option lets guest users call your lvlacinrosh. Later. if you want to pre\·enr 

guests from calling, cl ick this option again to deselect ir. 

) Close the <Guest> window. 

\0\Y the ~ lacintosh \\·ill accept calls from any guest. 

Monitoring and disconnecting a user 

\Vhen a user calls your \lacinrosh, the Remote Access Starus 'i\·indow displays the user's 

name and ho\\' long the user has been connected. You also use the Remote Access Status 
\\'indo\\' to disconnect a user. 

1 Choose Status from the Windows menu to view the Remote Access Status 
window. 

The Remote Access Status window opens. 

~0 Remot e Access Status 

This icon indic:ucs_J_~ 
your ~bcintosh has '1.. Connec tion Establi shed 

:111SII'Crcd a rail. -------------- 1 
Connec t ed with : Q Roge-r Brenner 

Time- connected : 1 :27 :54 

Time r e maining : UnHmHed 

Clirk here to -----+-----i[lon7i-::sc;::o::;n::;-n~ec:'it:-'l 
di~conncct a user. 

2 Click Disconnect to disconnect the user. 
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3 Type the number of minutes that you want to elapse before the user is 
disconnected. 

Enrer 0 to disconnect the user immediately. 

Disconne ct user " Keri Sha les" 

in ~ minutes. 

( Cance l J n OK JJ 

4 Click OK. 

The Remote Access Starus \Yinclow displays the time remaining until rhe user is 

disconnected. The user receh·es a message indica ring the amount of rime prior ro 

disconnection. The user also receives warning messages 10 minutes, 5 minutes. and 

2 minutes before being disconnecrecl, if enough rime is aiiO\Yecl. 

After you begin rhe disconnection process. the Remote Access Status ~Yinclow displays a 
Cancel burton. Clicking Cancel hairs the disconnection process. The user rhen receiYes a 

message indicating that the disconnection process has been stopped. and the user can 

remain connected for the amount of time you\·e specified in the Remote Access Setup 

control panel. 

Quitting the Retnote Access progran1 
You can quit the Remote Access program at anytime by using the Quit command from 

the File menu. If a user is currenrly connected to your ~lacintosh. the connection remains 

open because quitting the Remote Access program has no effect on the connection. 
Quitting rhe program frees up memory for your computer to use for other processing. 

Y mdl need to reopen the program if you >;\·ant to disconnect a user. check the user"s 

status in rhe Remote Access, tatus \YinciO\Y, or look at the Acti,·iry Log (discussed in 
Chapter 3). If you reopen the program >;\-bile a connection is acti,·e. the Remote Access 
Status >;\·indo>;\- automatically opens. 

Quitting the Remote Access program 19 



2 Calling With Remote Access 

You can use AppleTalk Remote Access to call another Macintosh computer that also has 

Remote Access installed and is setup to answer your calls. If the other Macintosh is 

attached to an AppleTalk network, you 'll ha\·e access to the remote net\\·ork services as 

if your ~lacintosh is connected directly. To make calls, you first must install the 

AppleTalk Remote Access soft\vare and supply the necessary connection information. 



Setting up Ren1ote Access to n1ake calls 
Before you make a call. ~·ou need to do the follo,,·ing: 

• Install the Remote Access sofm·are. Follm\· the in ·tallarion procedures in the 

Introduction. 

• Connect a modem to your 1\'lacintosh and indicate your modem setup in the Remote 

Access , erup control panel. Follow the instructions in .. Indicating Your Modem 
Setup .. in Chapter 1. 

• Make sure that Remote Access software is installed on and a modem is connected to 

the Macinrosh you want to call. and that you can call that Macintosh as a guest or 
registered user. If you didn·t set up the other ~Iaci nrosh yourself. check ,,·irh the 

computer"s mmer or your network administrator to confirm that the Macintosh is set 
up to ans,,·er calls. 

If the ~ lacintosh you·re calling allows registered users only. the other Macintosh must 

ha,·e your name and pa ·s\\·ord in order to anS\Yer your call. Veri~· ho\\· your name 

and pass\\-ord \\·ere et by the computer's owner. so that you enrer marching 

information when you call. Also. if the other Macintosh uses callback. check that 

your telephone number is correct. 

To ans,rer your call, the ~ lacintosh you·re calling does not need the Remote Access 

program open. 1-!owe,·er, the other Macintosh and its modem must turned on. 

• Obtain the telephone number of the modem connected to the Macintosh you want to 

call. 

• Create a connection document. following the instructions in the next section. 
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Creating a connection document 

The information that Apple Talk Remote Access needs to access another Macintosh 

computer is stored in a connection dowment. By using multiple connection documents. 

you can sa\·e the infonnation needed to call different .\lacintosh computers. 

1 If necessary, double-click the Remote Access icon to open the program. 

fiiil+ 
~-T 

Remote Access 
tt 

A new untitled connection document appears on your screen \\'hen you open the 

program. (If you're continuing from the previous chapter. you should have an untitled 

connection document on your screen.) You can also create a new untitled connection 

document by using the \e\\· command rromthe File menu. 

Untitled 

Conn~ct as: 0 Gu~?st 

® Re9i!~.te-n·d Unr 

NamP : I MariJ Adams 

Password : II 
:=::::==:::::::::~---, 

Phon~ : L-_______ -...J 

0 Save mtJ password 

0 Remind me- of miJ conntction Pv eriJ : D m~nulu 

[ Connec t I 

2 Connect as a registered user. 

You can call another .Vlacintosh as a registered user or as a guest. When you open a ne\\· 

connection document. the l{egisteredlser button is selected automatically. Connecting 
as a guest is co\·erecl in the section "Connecting a~ a Guest" later in this chapter. 
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3 Enter your user name in the Name text box, if necessary, and press Tab. 

If the cursor is not in the \a me text box. tab to it or click in the box to place the cursor. 

Your user name must match the spelling that is regisrerl'd \\·ith the Macintosh you ~;yanr 

to cal l. bur capitalization doesn"tmauer. 

If you·re specified an mmer name for file !'!haring. the O\\"ner name :1ppears 

automatically in the Name text box of the connection document. 

4 Type your password in the Password text box and press Tab. 

Type in your IXISS\mrd exactly as registered with the ~,lacintosh you "·ant to ca ll. As you 

type. the characters appear as bullets ( • ) to pre,·ent someone else from reading your 

pass\\·ord. You must match uppercase and lo\\"ercase leuers exactly. 

+ Note If you auempt a connection \\·ith an incorr<.:ct pass\\·ord. an error message \\·ill 

appear and you can try again. l lo\\"e\'Cr, as a security precaution. if you tl\ to connect 
using an in\'alid pass\\"ord se,·en times consecuti,·ely. the other J\ lacintosh will remke 

your ability ro make a connection. In this case. you·ll need your connection pri,·ileges 

reinstated on the ~lacintosh you·re trying to call. Check " ·ith the O\mer of the other 

!vlacintosh or your net\\"ork admin istrator if you should need your pri,·ileges reinstated: 
that person must open your user icon in the L'scrs & Groups control panel and reselcct 

the option ··AIIo\\' user to dial in.·· • 

5 Type the phone number of the Macintosh you want to call. 

Enter the number as if you were dial ing directly. For example, if the Macintosh is in area 
code 818 and its phone number is )5)-1234. type: 

1 , 818-~~~-1234 

A comma in the phone number designates a p:1use. You can use clashes for readability. 
bur the program doesn·t require them. Also. Remote Access assumes you ·re dialing from 

a touch-tone phone. For information on pulse dialing and commands interpreted by the 
modem, refer to the section .. ~lodem Commands·· in Appendix A. 
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Important The option '·Save my password" lets you save your password in the 
connection document. If you save your pass'\vord. you '\von 't need to enter it '\vhenever 
you connect. However, this compromises the security of the computer you're calling. 
because anyone can then use your connection documtnt to connect. For a discussion of 
security considerations~ including passwords, refer to Chapter 3 ... Security and Efficiency 
Considerations ... For nuw. leave this checkbox blank. 

6 Click the "Remind me of my connection" checkbox if you want Remote Access 
to remind you periodically that you are connected to another Macintosh. Then 
type a number between 1 and 9999. This number tells Remote Access how 
often, in minutes, to remind you of the connection. 

This feature helps you avoid unintentional or prolonged connections. After your 
computer is connected to another Macintosh for the specified period of time, you will 
receive a message asking if you want to continue your connection. If you click OK, your 
·work will not be interrupted. If you do not respond \Vithin one minute, AppleTalk 
Remote Access will disconnect you. 

At this point. the connection document should look something like the following: 

Untitled 

Connect as : 0 Guest 

@ Registered User 

Name : I Mary Adams 

Password: I••••••• :======='-----, 
Phone: 19,555-1234 

0 Save my password 

18] Remind me of my connection e•tery :~minutE-s 

I Connect I 

You should now save the connection document, so you can use it later. 
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7 From the File menu, choose the Save As command to save the connection 
document. 

'a ring rhe connection document means you ''"on·r need to reenter the information ,,·hen 
you next call the same \ lacimosh. You can use the are As or Sa,·e command. or click 
the connection document's close box. You'll then recei,·e a prompt to enter a name for 
the connection document. Pick a name that describes the ~ laci n!Osh you're call ing. like 
"Bo ·ton Office" or ... \ lac at home ... The connection document icon ,,·ill appear in the 
folder \rhere it is sm·ed. You can store connection documents ,,·here,·er you like on your 
hard d i~k. 

t''l.~c at horne 

Changing or deleting connection information 

After you've sared a connection document. double-click its icon 10 open ir. You can ed it 
any of the information pre,·iously entered and sa,·e it for later use. 

To get riel of a connection document. drag it to the Trash and usc the Empty Tra~h 
command in the Finder to delete it. 
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Connecting as a guest 

To connect JS a guesr. open a connection documcnr and click the Guest butron. 

Untitled 

Conn~ct ~s : @ Gutl'st 

0 R•gis lerod Us•r 

0 ,:, ~ .. t- ~:~~: p~;.j.~··::-~:·-~ 

0 R~mind me of my connection e-very : D minutes 

( Connect 

The text boxes for Name and Password are unavailable. because you don't use those 

ro connect as a guesr. You can save the connection document as you would any 

connection document, so at some later time you can connect using the same 

information. :-!ore that to connect as a guest. the Macintosh you're calling must allmY 

guest access. Check "·ith rhe o"·ner of the ~!acintosh you're calling to find out if you can 

connect as a guesr. 
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Connecting to a ren1ote Macintosh 
or network 

Once you·ve installed Remote Access and have created a connection document. you can 
make a call to anorher ~ lacintosh. 

1 Double-click a connection document icon. 

This opens the connection document and the Remote Access program. 

2 Enter your password, if necessary. 

Mac at home 

Conn~ct as: 0 Gu~st 

@ RE>qist~rl!'d User 

Namf' : I Man,t Adams 

Password : I••••••• 
:=========~---, 

Phonp : 19 ,555-1234 

0 Save- my password 

[8] Remind me of my conne-ction e-vE>r~:~ : ~minute-s •.. ,,,, ... 
3 Click Connect. 

When you click Connect, AppleTalk Remote Access ca lls the other ~ lacintosh and tries to 
connect to it. The Remote Access tatus ~·indo\\" appears to allo~· you to cancel the 

connection arrempt before the connection is completed and to sho\\" the progres-; of 

mur connection. 

::0 Remote Recess St atus 

l his icon indicne.,-1-~ 
Calling 1h:n vou·ve died t 

:11101h<:r ~I:Kin!o~h . -------------- 1 
St atus: Initiating connE>ctlon ... 

Cancel 
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The other Macintosh ,·erifies your name ancl jxtss\\-orcl. and the connection is then 

established. 

+ Note If the other J\ lacintosh has callback turned on. mu are temporarily 

disconnected from the other \tlacintosh ,,·bile it auempts to call you back. Your phone 

,,·ill ring and the modem \Yill ans'i\-er the call. Then. the connection is established. Refer 

to Chapter 3 for more information on callback. • 

Other ways to connect 

Another way you can open the Remore Access program is to drag the connection 

document onto the Remote Access icon. 

a pollo 
4 items 7 .8 MB in disk I 0.8 MB availabl• 

Syst('om Fold€'r 

I 
!:ffit§Uiijfj f1ac at home-

¢1 

This opens the !{emote Access program and the connection document. You then 

click the Connect burton in the connection document window to call another Macintosh. 

As a shortcut, hold down the :~: key when double-clicking the connection 

document or when dragging the connection document onto the Remote Access icon. 
The program ,,·ill then automatically tty to connect using that connection document. 

Connecting to a remote ~ lacintosh or net\vork 29 



Viewing your connection status 

Whenever the Remote Access program is open, you can riew your connection status 

by looking at the Remote Access Status window. To open the \rinclmr. choose the Status 

command from the WindO'iYS menu. 

The Remote Access Status window appears. shm,·ing details of your connection. 

:o Remote Recess Status 

j~ Connection Established 

Connect ed to : 13) lan's Mac 

r;me connec t ed : 0 :01 :00 

Time remaining : Un11mitf1:1 

I Disconnect 

The Remote Access Starus "·indow tells you where you·re connected and for how 

long you're been connected. Also shown is the time remaining for your connection. The 

time limit is set by the m,·ner of the Macintosh you\·e called. or you may h;l\·e no time 

limit for your connection. indicated by the word ··cnlimited.·· You can dick the close box 

to close the Remote Access Status \\'inclow. 

The \\' inclo\\·s menu also coma ins the Activity Log command. The Actirity Log 

contains a listi ng of all erents inmlving Remote Access. such as connections made or 
attempted. Csing the Acti,·ity Log is corered in Chapter 3. 
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Selecting ren1ote network services 
AppleTalk Remote Access a!IOI;\'S you simultaneous usc of the sctYiccs of your local 
AppleTalk net\\·ork as \\·ell as those of the network of the ~lacinrosh you·\'e called. 

ptmiclecl the other ,vlacintosh is set up to allo\\. access to the remote net\York. Once 
you\·e established a connection to a remote AppleTalk net\York \\·ith Remote Access. 

you select nemwk services in the Chooser \\·indO\\. or use other net\\"Ork products such 

as electronic mail , follm\·ing the same steps you \\·ould to u ·e the sen·ice on your local 
net\\·ork . 

As an example, the following steps show ho\\ to prim to a Laser\'\triter that"s on a 

remote AppleTalk network. Let"s say you have not yet used Remote Access to connect. 

Assuming your Macintosh has an AppleTalk network printer such as a LaserWriter 

attached. the Chooser winclov.; shows you the local services available to you: 

Appl•Shar• 

0 

Select a LaserWrit er: 
I • • . 

@Active 
AppleTall( 0 Inacti ve 

7.0 

Now, call the other Macintosh, establishing a connection to the remote AppleTalk 

network. 
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1 Look at the Chooser window. 

The Chooser window display:-. the network services and AppleTa lk zones that are 

currently available to you. Not ice the Laser\XIritcr!' ava ilable from the remote net\\·ork: 

0 

Appi•Shar. 

AppleTalk Zones: 

~ 
·~!:!! · ........ 

!i'ij5fMttl 

Chooser 

Select a Laserwnter. 
I • • • 

Production LaserWri ter 
; Pub 1 i ca t1 ons LaserWn ter 

Creative SerVICes m 
General Admini stration 
Legal 
Marketing 
Production 
Publications 
Sales 
Technica l Writing Appl eTalk @ACtiVe 

0 Inactive 

0 

7.0 

2 Selecl a LaserWriter as you normally would, then close the Chooser. 

You can nO\\" print to the remote Laser\Vriter. 

Disconnecting fron1 the ren1ote netvvork 

Once you establish a connection with a remote net\York. the Remote Access Status 

window displays a Disconnect huuon. 

1 From the Windows menu, choose Status. 

2 Click Disconnect. 

When you click Disconnect, the connection between your computer and rhc other 

Macintosh is broken. HO\\"C\'er. the Remote Access program is still open. so you can 
make another connection or create a new connection document. 
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If for some reason you shut clown your Jvlacintosh while connected to a remote network, 

the connection is automatically broken. 

Quitting the Ren1ote Access progran1 

You can quit the Hemote Access program at any time by using the Quit command from 
the File menu. If yuu·re currently connected to a remote net" ork. your connection 

remains established because quitting the program has no effect on the connection. 

Quitting the program frees up memoty for your computer to use for other processing. 

You cannot quit if you're in the process of connecting or disconnecting. 
If you quit while you·re connected to a remote network. yolt"l l see a dialog box that 

reminds you of your connection. You must choose to disconnect and quit, stay 

connected and quit, or cancel. 

The connection that you established is still actiue. 

Do you want to quit the Remote Access application 
and stay connected? 

Cancel l [ Disconnect IS" Quit ) n Stay Connected IS" Quit D 

Hemember that ymt"ll need to reopen the program if you want to disconnect, open a 

connection document. or check your connection status in the Remote Access Status 

window. If you reopen rhe program while a connection is active, rhe Remote Access 

Status ,,·indO\r automatically opens. 
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3 Security and Efficiency Considerations 

To get the most out of AppleTalk Remote Access, you can rake cenain steps to make 

sure your Macintosh is secure and that you're using Remote Access efficiently. Remote 

Access provides several measures of security, including the ability to monitor users. This 

chapter discusses efficiency measures and Remote Access security along with general 

considerations for keeping your nem·ork secure. 



Using the Activity Log 

The Acti,·iry Log documents all Remote Access erents. It keeps track of ,,·hen a Remote 

Access connection is attempted. established. or eli -connected. indicating if the 

connection is a connection you initiated or if another user called your !l lacinrosh. The 

Acti\·iry Log retains the 1.000 most recent activities. 

Folio,,· these steps to ,·ie" · the Actirity Log: 

1 Double-click the Remote Access icon to open the program, if necessary. 

2 From the Windows menu, choose Activity Log. 

The Activity Log appears displaying the current and most recent activity of your 

1vlacinrosh. The first column shows the date and time of the activity. A diamond ( • ) 

preceding the first column indicates that your Macintosh established the connection by 
anS\\·ering a call from another user. The second column displays the user name. 

The third column describes the activity. An exclamation point (!) precedes the activity if 

an unusual event occurred. This alerts you to activities such as an unknown user trying 

to call or a user trying to connect with an incorrect password. 

0 
55 Log Entt· i•s 

Dat• Us•r 

Mon, Jul 29, 1991 1 0 :29 AM Mary Adams 

Sa\ , Jul 27, 19911 2 :47PM Pubs 

Sat, Ju127, 1991 12 :45 PM Pubs 

Sat, Jul 27, 1991 12 :43 PM Pubs 

• ll'•d, Ju11 0, 1991 8 :50AM K•ri Vagn•r 

• W•d, Ju1 10 , 19916:17 AM K•riVagnor 

• ll'•d, Ju11 0 , 19916:17 AM KoriVagn•r 

• W•d, Ju11 0 , 1991 6 :17AM 

• W•d, Ju110, 1991 6 :17AM 

Actiuity Log 

Log Entry 

Dialing 9 ,555· 1234 

Conn•ction \ormmat•d aftor 0 :02 :29. 

Conn~c tion u tabhshtd v 1a callback at 9 ,600 bps. 

Dialing 555· 1236 

Conne-c tion terminated after 2 :32 :43 . 

Connection •stablish•d via callback a\ 9 ,600 bps . 

Dialing 555·1 237 

Initiating callback 

Incoming call . 

• W•d, Ju13 , 1991 6:25PM Mar~ Johnson Connection atte-mpt f.a1led · Unreg1stered user. 

• ll'•d,Ju13, 1991 6 :25PM lncom;ng call 

• Tu•, Ju12, 1991 6:46 P11 Keori "rr agn~r· Connection t~rmina t ed aft~r 0 :04 :07 . 
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Copying, saving, and clearing the Activity Log 

To save the Activity Log for your records, you em select the Activity Log entries and 
copy them to the Clipboard. Click the entry or Shift-click the range of entries you want to 

copy. or use Select All from the Edit menu, then use the Copy command from the Edit 

menu. 

55 Log En\rios 

Oat~ Us~r 

Mon, Jul 29, 1991 1 0 :29 AM Mary Adams 

Sat,Ju127, 1991 ! 2 :47PM Pubs 

Pubs 

Ked Wagner 

Log Entry 

Dialing 9,555-1234 

Conn•ction t•rminat•d aft•r 0 :02 :29. 

Conne-ction e-stablished via callback at 9 _,600 bps. 

Dialing 555-1236 

Incoming calL 

ConnPcHon terminated after 0 :04 :07. 

' : : : ~ ' : r = : : : : : ~ : : = : ; = = = . • 

The entries arc copied to the Clipboard as tab-delimited text, so you can paste this 
into a spreadsheet file. Use this spreadsheet file to save multiple records of the Activity 

Log, to son and search through the in format ion, or to print. 
You can also save the Activity Log as a text file. To do this, choose Save As from the 

File menu. You'll be prompted to enter a name for the text file, which is saved on the 

disk you specify. By default, the text file is saved under the name Log, follovved by a 
range of dates that correspond to the ea rliest and latest activities in the Activity Log. Use 

any word-processing or spreadsheet program to view or edit the text file. 

Should you wish ro clear the Activity Log completely. choose Clear Log from the Edit 
menu. A dialog box will appear, prompting you to confirm that you wish to clear the 
Activity Log. After you clear the Acrivity Log, those entries cannot be recovered, so you 

should save the log before clearing it. 
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Maintaining security for your Macintosh 
and network 

Before allm,·ing users to call your Macintosh, make sure you\ re established what 
information you want others to have access to. You should set up file sharing for those 
folders you \Yant other reople to use. If you do not use file sharing, a user can still call 
your Macintosh but will not have access to your computer's folders or hard disks. 

If you wanr to call your own Macintosh, then tu rn on file sharing but do not share any 
folders. This way you. as the owner, always have access to all your files under fi le sharing. 

If you are setting up Remote Access on a Macintosh that is parr of an AppleTalk 
net\vork, security is an especially imrorranr issue. Remote Access includes several 
features that provide security for your net\vork . You can register users, use the callback 
option, and limit the access users have to the network. 

Register users 

When you call another ~ lacintosh, you gain access to all public files, file ser\·ers. and 
printers on the nemw k to " ·hich that Macintosh is connee1ed (hut only if the remote 
Macintosh is set up to allow access to the entire network). Each wlacintosh using Remote 
Access stores the name and paSS\YOrd of every user registered ro call . Registered users 
are assigned pass,,·ords that they must enter each time they call the Macintosh. A user's 
name and pass" ·ord act as a ke>r- no one can enter the network without knowing and 
entering both of them correctly. You should encourage users to change their passwords 
frequently. 

Don ·r all mY guest access 

By allo" ·ing guests to call your ~laci nrosh . you allo,,· unknown users to access your 
network. If net\\w k security is a concern, then do not allow guest users to call. 
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Avoid saving your password 

Avoid saving your password with your connection document (the "Save my password" 
checkbox should not be checked). If the password is saved. anyone can use that 
connection document to call the Macintosh that you are registered to use. 

Mac at home 

Connect as : Q Gu!?st 

@Regis tered User 

Nam~: I Mary Adams 

Passw ord : I••••••• 
~======~---, 

Phone : 19,555- 1234 

A1·oitl Sal·ing your---~Save my password 

paS.)\I'Ord. [2] Remind me of my connect ion every : §=:1 minutes 

[ Connect ) 

Limits to connection attempts 

When a user calls a Macintosh, the user is allowed se,·en consecutive tries to enter the 
correct password. After seren incorrect password entries, the user's connection 
privileges are revoked and the Macintosh owner must set up the user again to call that 
computer. This seven-ny limit helps prevent an unregistered user from guessing a 
password. 

Select callback 

After a user calls and is verified as a registered user, the .'vlacintosh can tempora rily break 
the connection and. using a phone number stored ,,·ith the user's name. call the user 
back. This callback feature gives further assurance that the user is authentic. because the 
user must call from a predetermined phone number. You can set the callback option for 
each user in the user's information window in rhc Users & Groups control panel. 
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;;o Mary Adams 

User Passw ord : I••••••• 

LJ File Sharing 
.~. (g) Allow us•r lo connocl 

[8J Allow user to change- password 

~ Program Linking 
:~ 0 Allow user to link to progr·ams 

on th1s Macintosh 

~ Remote Recess 
l!iJf! [8) Allow user to dial m 

Turn on ctllb:t<..·k ---f---[8] can back 4t • : h=W4ii•f 
here. 

Deny access to the network 

You can limit users· access 10 only the Macintosh called, preventing all users from 

accessing services on the remote network. 

Allow access to entire network Allow access to this Macintosh only 

,•' J 

~ ~u/1:1 ., ""'" ;, lu II" 
t'llfil'l! 1/e///'()/k 
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To limit access, open the Remote Access Setup window. Click the button to allow 
access to "this Macimosh only.'· 

0 Remote Recess Setup 

~ Modem Setup 

Mod•m: I Appl• Mod•m 2400 T I Port : 

Mod•m Speaker·: @ On 0 Off 

~ Remote Recess Answering Setup 

(8] Answer calls 

0 Maximum connection timt> : 10'""'"" 1 minutl's ........... ; 

Mod•m Port 

A How access to : Q e-ntirt> network @this Macintosh only 

Require a pasS'I\·ord to set up anw:ering on the network 

On a large net\vork, the network administrator can require users to enter a paSS\YOrcl tO 

set up ans'iYering on the network. Check with your administrator to see if this feature is 

implemented and to find out your network password. If the feature is implemented. 

you·ll receire a dialog box when you set up your ~~Iacintosh to answer ca lls in the 

Remote Access Setup control panel. 

A password is required to set up 
answering on this network. 

Password: 

[ Cancel J n OK )) 
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Using Ren1ote Access efficiently 
The following sections discuss how to use Remote Access efficiently and address special 
concerns for hardware setup. 

Connecting efficiently 

Remember that you are using standard telephone lines to connect to a remote network. 
Just as you are billed for your roll calls and long-distance calls. you are also billed if you 
call a Macintosh outside your local calling area. 

If a Macintosh you're calling has the callback option turned on, the other Macintosh 
disconnects your call and immediately calls you back. The other Macintosh then 
originates the phone connection and becomes responsible for the charges. 

The following guidelines can help keep your long-distance phone charges to a 
minimum: 

• Disconnect as soon as you no longer need to use the remote network. 

• Do nor open programs such as word processors, spreadsheets, and graphics 
programs on the remote network. Because the program will run over telephone 
lines, commands may take an extraordinarily long time to complete. 

• Prepare files as much as possible before you make a connection. 

• Set a maximum connection time to limit users who call your computer. 

• Use the option "Remind me of my connection." This keeps you from forgetting about 
a connection, because you must respond to the prompt or Remote Access 
disconnects you. 

• As soon as you finish using a file server volume, drag the volume to the Trash to 
disconnect from the server. 

• While you're using file server volumes. don't leave their windows open. These 
windows are updated periodically causing unnecessary net\vork traffic. 
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Selecting remote net\YOrk sen·ices only 

\\"hen AppleTalk Remote Access is installed. the \ em·ork control panel contains an 
additional icon called Remore Only. You use the Ner~York control panel to select the 
rype of network to which you wam to connect locally. The default is LocaiTalk, \\·hich 
uses the printer port on your ,\ lacinrosh to connect to ApplcTalk networks. You may also 
see other icons depending on your network setup. 

:::o Network 

Select an App1eT.afk connfchon : 

II ~ 
Q 

' 

Ill R•mot• Onlv 

0 

You might select Remote Only for l\YO reasons: 

I. To turn otT access to your local AppleTalk net\\·ork (Loca lTalk. EtherTalk, or 
TokenTalk). so you sec only the remote nem·ork when you make a Remote Access 

connection. 

Sometimes you can'tlocare a sen·ice on the remote network because a sen·ice on 
your local network has the same address. This is similar ro phone numbers, for which 

two people in different area codes may have the same seven-digit phone number. If 
you don·r specify the area code and dial only the seven-digit number, you cal l the 
person ~·ho is in the same area code as you. Selecting Remote Only is like dialing the 
area code. meaning you call the per ·on outside your local area. When you select 
Remote Only. access to the local network is shut orr. ensuring that all sen·ices on the 
remote net,,·ork are accessible. 
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With Loca!Talk, EtherTalk, or TokenTalk selected With Remote Only selected 

i.OC:IlllL:lii'Ork lkmOie network loc:ll network Remote nem·ork 

lour .llacintosh cm1 see all del'ices 
0 11 the local and remote netll'orks. 

!'our .1/acintosh cm1 see all devices 
011 the remote netll'ork Oil~)'. 

2. To turn off Loca!Talk 10 free up the printer port on your ~lacinrosh for other uses. 
such as printing to an Image Writer or SryleWriter. 

If you want to use your printer port for something other than LocaiTalk, maybe to 
print to a Style\XIriter or lmage\Xfriter, you need to select Remote Only. This shuts off 
access to the local network, leaving the printer port free for another use. Since 

Remote Access is a type of AppleTalk connection, making AppleTalk inactive in the 
Chooser means you can't use Remote Access. So if you want to use Remote Access 

and the printer port, you need to select Remote Only. 

Be a\\·are that if your .\lacintosh is currently connected to a remote network and you 
switch from one AppleTalk connection type to another in the :.JeC\\·ork control panel, 
such as from LocaiTalk or EtherTalk to Remote Only, you will be disconnected. 
However. you can always reconnect. 
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Appendix A: Using Modems 
With AppleTalk Retnote Access 

AppleTalk Remote Access includes scripts to use many popular Hayes-compatible 
modems within the United States. This appendix lists the modems that have scripts 
included ,,·irh rhe AppleTalk Remore Accc ·s soft,,·are and discusses ~·hat you can do if 
your modem is nor included. This appendix also sho~·s ho~· to connect a typical modem 
to your ~ lacinrosh and lists standard modem commands. 

Modems you can use with Remote Access 

AppleTalk Remote Access includes scripts for the following modems for use within the 
United States. If you're using AppleTalk Remote Access outside of the U.S., contact your 
authorized Apple reseller or representative for modem information. For the best 
performance. Apple suggests you use a 9600-bps modem. 

2400 hps!V.22bis modems 

• Apple .'vlodem 2400 (supports all 2400-bps Apple modems) 

• Abaron lnterFax 2-1196 

• Global Village Teleport 

• Hayes Smart/llodem 2400 

• .Microcom iVIicroporte 1024 

• Practical Peripherals 2400SA 

• Prometheus ProModem 2400 



• Supra SupraModem 2400 

• US Robotics Courier 2400e 

9600 bps!V.32 and 14400 bps!V.32bis modems 

• DSI 9624 LE/lE Plus 

• Hayes Ultra 96 

• Farallon Remote V.32 

• Microcom MacMoclem V.32 

• MultiTech Multi.MoclemV32 

• Practical Peripherals 9600SA 

• Prometheus ProModem Plus/Ultima 

• T elebit T1600 

• US Robotics Courier V.32bis 

For every type of modem that Remote Access supports, a script resides in the 
Extensions folder \Vithin your System Folder. Modem scripts contain program code used 
by the Remote Access software to communicate with that particular modem type. 

{{your modenz is not included 

Your modem should conform to the CCITI ( Comite Consultatif International 
TeU~graphique et Telephonique) standards V.22bis, V.32, or V.32bis. If you want to use 
Remote Access with a modem not listed above, a script may be available for your 
modem. Check with one of the following sources to see if a modem script is available: 

• your modem vendor 

• your authorized Apple reseller or representative 

• the Apple Customer Assistance Center (1-800-776-2333 in the U.S.) 

• if you're a subscriber, the Apple Technical Coordinator Answerline or the Apple 
Software Development Answerline 

Some modems not included with the Remote Access software may need a cable that 
supports CTS (Clear To Send). Call the Apple Customer Assistance Center for more 
information. 
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Writing modem scripts 

If you understand connection control languages (CCL<;) and are an experienced 

programmer. you may he able to '-'Tite the necessary modem script yourself. The 
Apple Talk Remote Access ~ Iodem Toolkit is ;n·ailable through APDA (Apple 

Programmers and Developers Association). The kit includes a HyperCard stack and 

appropriate documentation to help you build scripts. 

APDA offers convenient worldwide access to over 300 Apple and third-party 

development tools, resources, and information for anyone interested in developing 
applications on Apple platforms. To order products or get additional information 

contact: 

APDA 

Apple Computer. Inc. 

20525 Mariani AYenue, M/S 33-G 
Cupertino, California 95014-6299 
800-282-2732 ( ·nited States) 

800-637-0029 (Canada) 

408-562-3910 (International) 

408-562-3971 (Fax) 
171-576 (TELEX) 
AppleLink: APDA 

Connecting your modem 

How you set up your modem depends on the type of modem you're using. The 
documentation that came with your modem should IXo,·ide specific details on ho\\· to 

connect your modem to your computer. Depending on the type of modem or ~ Iacintosh 

you use. you·ll need to do the follo..,.·ing: 

• Connect your modem to your telephone lim:. 

• Connect your modem 10 your telephone (optional). 

• Connect your modem to your Macintosh. 

• Connect a power supply ro your modem. 
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The following picture offers a typica l example that shows an Apple Data Modem 

connected to a M;.~cintosh: 

To po11 cr supply 

To telcphon.: 

To telephon<: line 

To peripheml dt:vic.: 

To computer 

Modem commands 

Standard commands are interpreted by most modems available in the United States. You 

enter these commands as characters in the telephone number sent to the modem. The 

following table lists standard commands, but you should refer 10 your modem manual 

for a complete description of the commands it interprets. 

Command 
( clw racier) 

0-9,=, * 

T 

p 

Fllllcl iOII 

Digits and characters used for dialing. 

Causes all digits follo\\'ing to he touch-tone dia led (the default). 

Causes all digits follm\'ing to be pulse dialed. 

Pauses before continuing. 
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Pulse dialing 

AppleTalk Remote Access assumes you're dialing from a touch-tone phone. If you 
require pulse dialing! precede the number with a P! as shown here: 

Pl,818-555-1234 

If you need a combination of pulse and touch-tone! precede the numbers with P (for 
pulse) and T (for touch-tone) as appropriate. You may need to do this if you're making a 
long distance call with pulse dialing, and you first connect to your long-distance carrier's 
lines then enter an access code using touch-tone. In this case, the phone number you 
enter should look something like this: 

Pl,818-555-1234 T342 
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Appendix B: Troubleshooting 

While using AppleTalk Remote Access, you may occasionally encounrer a problem. This 
appendix provides information that is common to most modems and offers suggestions 
for solving problems. 

You can't make a calL 

• Make sure your modem is connected properly and turned on. Refer to your modem 
documentation if you have any problems. 

• Make sure your modem type and port are selected in the Remote Access Setup 

control panel. 

Your modem is working, but you can't connect to another Macintosh. 

• Make sure you're a registered user on d1e other Macintosh. Check that you've enrered 
your user name and password correctly. 

• Find out if the other Macintosh is set up to call you back, and verify that your 
telephone number is correct. 

• Make sure the other Macintosh and its modem are turned on, and the i\lacintosh is 
set up to answer calls. 



You are losing the connection. 

• You may have noisy phone lines. Contact your phone company. 

• Make sure you've selected the correct modem type in the Remote Access Setup 
control panel. 

• The call-waiting feature can disrupt the connection when someone tries to call you. 
When you enter the phone number in the connection document, precede the 
number with the code to turn off call waiting. However, if the other Macintosh has 
callback turned on, your modem first hangs up, which reenables call waiting. Contact 
your phone company for information on how to turn off call waiting. 

The response time from the remote network is slow. 

• Make sure the Macintosh you've called is using a 9600-bps modem. Look in the 
Activity Log to check the speed the two modems are using. 

• Refer to the section "Using Remote Access Efficiently" in Chapter 3 to see if you can 
save time during the connection. 

After you connect to a remote network, you have problems with your 
Image Writer or another device connected to the printer port. 

• Select Remote Only in the Network control panel to redirect AppleTalk and allow 
you to print to your serial printer. Refer to the section "Selecting Remote Network 
Services Only" in Chapter 3 for more information. 

After you connect to a remote network, you cannot access your local network. 

• Select LocalTalk (or EtherTalk or Token Talk) in the Network control panel to access 
your local network. Refer to the section "Selecting Remote Network Services Only" in 
Chapter 3 for more information. 
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Other programs that use the serial port don't function properly, you see a 
dialog box that says the serial port is in use, or your Macintosh freezes during 
shutdown. 

• When the option "Answer calls" is selected in the Remote Access Setup control panel, 
the serial port is in use by Remote Access. To use other programs that need the serial 
port, tum off the option "Answer calls." 

• If your other program is incompatible with Remote Access, contact your authorized 
Apple Reseller for more information. 
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